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Sažetak
U radu je predstavljen automatizirani postupak izrade litoloških 

stupova koji se konceptualno bazira na tri alata: Microsoft (MS) Access 
programu, LogPlot programu te Visual Basic (VB) makroima za MS 
Excel. MS Access osigurava profesionalnu pohranu litoloških podataka 
koji se na taj način mogu lakše i brže unositi nego u LogPlotu, naknadno 
pretraživati, ažurirati te koristiti u druge svrhe, dok LogPlot osigurava 
mnoštvo alata za izradu litoloških stupova. VB makroi omogućuju 
prijenos litoloških podataka iz MS Accessa u LogPlot na način da podatke 
pohranjene u MS Accessu konvertiraju u tekstualne (ASCII) datoteke 
koje LogPlot može koristiti za izradu litoloških stupova. Predstavljeni 
koncept uvelike olakšava izradu litoloških stupova, a automatizirani 
postupak omogućuje obradu velikog broja podataka odnosno izradu 
velikog broja litoloških stupova bušotina u kratkom roku.
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Abstract
Paper presents automated technique for creating lithologic log 

plots. Technique is based on three computer tools: Microsoft (MS) 
Access program, LogPlot program, and Visual Basic (VB) macros for 
MS Excel. MS Access ensures professional storage of lithologic data 
which can be in that way easier and faster entered, searched, updated, 
and also used for different purposes, while LogPlot provides tools for 
creating lithologic log plots. VB macros enable transfer of lithologic 
data from MS Access to LogPlot. Data stored in MS Access are exported 
in ASCII files which are later used by LogPlot for creation of lithologic 
log plots. Presented concept facilitates creation of lithologic log plots, 
and automated technique enables processing of a large number of data 
i.e. creation of lareg number lithologic log plots in a short period of 
time.

UVOD

Pojava računalnih alata za obradu geoloških podataka 
uvelike je olakšala, ubrzala i poboljšala postupak izrade 
geoloških stupova, profila, karata, modela, itd. Jedan 
od najčešće korištenih i najdostupnijih alata za izradu 
litoloških stupova, a čiji postupak izrade je razmatran u 
ovom radu, je program LogPlot (RockWare Inc.). LogPlot 
sadrži mnoštvo alata koji omogućuju jednostavnu izradu 
litoloških stupova koristeći podatke determinacije 
litološkog sastava u bušotinama. Da bi LogPlot podatke 
determinacije mogao koristiti u svrhu izrade litoloških 
stupova, potrebno ih je prethodno pohraniti u tekstualne 
(ASCII) datoteke strogo definirane strukture (LogPlot, 
2003). Ovakav način pripreme podataka otežava i 
znatno usporava njihov unos, potencijalno naknadno 
pretraživanje, ažuriranje ili pak korištenje u neke druge 
svrhe.

Podaci o litološkoj determinaciji bušotina se u 
većini slučajeva, ako se pohranjuju u digitalnom obliku, 

pohranjuju u profesionalne baze podataka kao što je to 
npr. MS Access, što osigurava brz i jednostavan unos, 
mogućnost pretraživanja te ažuriranja baze podataka. S 
obzirom da LogPlot ne podržava mogućnost jednostavnog 
korištenja podataka pohranjenih u MS Accessu, iste bi, u 
slučaju da se žele koristiti u svrhu izrade litoloških stupova, 
bilo potrebno ponovno unositi u LogPlot. Višestruko 
ručno unošenje podataka u tom slučaju povećava 
mogućnost pogreške te oduzima vrijeme. Pohranjuju li 
se podaci o litološkoj determinaciji bušotina direktno u 
LogPlot gdje se spremaju u tekstualne datoteke, gubi se 
mogućnost jednostavnog i brzog pretraživanja, ažuriranja 
i unosa podataka, a pohranjeni podaci se zbog strukture 
tekstualnih datoteka ne mogu koristiti u druge svrhe.

VB makroi (Microsoft Excel, 2002) predstavljeni 
u ovom radu napisani su sa svrhom prijenosa litoloških 
podataka iz MS Accessa u LogPlot, čime je ostvarena 
veza između dva softvera, MS Accessa namijenjenog 
profesionalnoj pohrani podataka te LogPlota namijenjenog 
izradi litoloških stupova.
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STRUKTURA BAZE PODATAKA

Baza podataka korištena u radu namijenjena je pohrani 
podataka determinacije litološkog sastava u bušotinama, 
a sadrži dvije osnovne tablice: (1) tablicu s općenitim 
podacima o bušotinama kao što su šifre bušotina, oznake 
u elaboratu, x, y i z koordinate ušća bušotina; i (2) 
tablicu s litološkim podacima koja sadrži litološki opis 
s pripadnim dubinskim intervalima te ključnim riječima 
na osnovi kojih se kod izrade litološkog stupa svakoj 
jedinici pridodaje pripadna šrafura. U slučaju da se u 
tablicu unese ključna riječ za koju šrafura u LogPlotu 
nije definirana, ista se na litološkom stupu ne iscrtava, 
tj. pripadni interval ostaje neispunjen. U tom slučaju 
potrebno je u LogPlotu kreirati odgovarajuću šrafuru 
koristeći opciju Tools → Keyword Editor, s nazivom koji 
odgovara ključnoj riječi u tablici. Spomenuta tablica isto 
tako sadrži i šifre bušotina preko kojih se u konačnici 
ostvaruje veza između dviju tablica (Microsoft Access, 
2002), a koja omogućuje naknadno kreiranje upita koji se 
upućuju na obje tablice. Upit objedinjuje podatke iz dviju 
osnovnih tablica, a dizajniran je na način da sadrži sve 
podatke koji su LogPlotu neophodni za izradu litoloških 
stupova.

Ovako dizajnirana baza podataka zadovoljava kriterije 
brzog i jednostavnog unosa kako općenitih podataka, tako 
i litoloških podataka bušotina te preko upita istovremeno 
osigurava objedinjavanje podataka potrebnih za izradu 
litoloških stupova.

KONCEPT AUTOMATIZIRANE IZRADE 
LITOLOŠKIH STUPOVA

Koncept automatizirane izrade litoloških stupova 
podređen je konceptu izrade stupova koristeći alate 
LogPlota. Da bi uz pomoć LogPlota kreirali litološki stup 
potrebne su dvije datoteke s ulaznim podacima (sl. 1): (1) 
*.DAT datoteka koja sadrži općenite podatke o bušotini 
kao i podatke o determinaciji litologije u bušotinama te 
po sadržaju u potpunosti odgovara sadržaju upita iz baze 
podataka; te (2) *.LDF (Log Design File) datoteka koja 
sadrži definiran izgled litološkog stupa. *.LDF datoteku 
odnosno izgled litološkog stupa potrebno je kreirati u 
LogPlotu koristeći Log Design modul.

U slučaju postojanja *.DAT i *.LDF datoteka, u 
LogPlotu se stupove može kreirati na tri načina: (1) 
koristeći opciju Compile a Log; (2) koristeći opciju Batch 
Compile; te (3) koristeći opciju Command Line Batch 
Compile. Od tri navedene moguće opcije, najzanimljivija 
je treća opcija koja je ujedno i korištena u ovom radu, 
a koja omogućuje u potpunosti automatiziranu izradu 
litoloških stupova pod uvjetom da se prethodno osiguraju 
sve potrebne ulazne datoteke (vidi sl. 1).

Naredba Command Line Batch Compile koristi 
komandnu liniju (Command Prompt), čime se izbjegava 
pokretanje LogPlot programa i manualno učitavanje 

*.DAT i *.LDF datoteka te izrada stupova, što znatno 
skraćuje potrebno vrijeme obrade.

Da bi mogli koristiti Command Line Batch Compile 
naredbu potrebno je prethodno kreirati nekoliko 
različitih datoteka s potrebnim ulaznim podacima (vidi 
sl. 1). Kreiranje *.BAT, *.TXT i *.DAT datoteka vrši se 
automatizirano za svaku bušotinu pojedinačno koristeći 
VB makroe, dok se kreiranje *.LDF datoteke vrši u Log 
Design prozoru LogPlot programa i ona se koristi za 
definiranje izgleda litoloških stupova svih bušotina.

Slika 1. Sumarni prikaz ulaznih i izlaznih datoteka

Figure 1 Summary of the input and output files

Datoteka *.BAT je izvršna datoteka koja se pokreće 
u komandnoj liniji (Command Prompt). Sadrži dvije 
naredbe koje se izvršavaju nakon njenog pokretanja. 
Izvršavanjem prve naredbe pokreće se program LogPlot 
dok se izvršavanjem druge naredbe pokreće *.TXT 
datoteka s daljnjim instrukcijama. Datoteka *.TXT se 
u narednim koracima ponaša kao izvršna datoteka što 
znači da se naredbe zapisane u njoj izvršavaju zadanim 
redoslijedom.

Izvršavanjem naredbi u *.TXT datoteci, u pokrenuti 
LogPlot program automatizirano se učitavaju ulazne 
*.DAT i *.LDF datoteke, zatim potrebni podaci o 
vertikalnom mjerilu za iscrtavanje litološkog stupa, 
jedinicama (metri ili stope), dubini i marginama grafičkog 
prikaza litološkog stupa te podaci o izlaznoj *.HTM 
datoteci u koju će se spremiti kreirani litološki stup. 
Vertikalno mjerilo iscrtavanja litološkog stupa izračunava 
se s obzirom na dubinu bušotine i veličinu A4 papira čime 
se uvjetuje iscrtavanje litološkog stupa na jedan A4 papir. 
U slučaju da korisnik želi iscrtati litološki stup na neku 
drugu veličinu papira, potrebno je promijeniti vertikalno 
mjerilo iscrtavanja litološkog stupa u *.TXT datoteci. 
Koristeći učitane podatke LogPlot automatizirano kreira 
litološki stup koji pohranjuje u izlaznu *.HTM datoteku 
(vidi sl. 1). Time se izvođenje potrebnih operacija od 
strane korisnika svodi na pokretanje *.BAT datoteke dok 
se kompletan proces od pokretanja LogPlot programa, 
učitavanja ulaznih datoteka i kreiranja izlazne datoteke s 
iscrtanim stupom izvodi automatizirano.
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U slučaju postojanja velikog broja bušotina može se 
kreirati još jedna sumarna batch izvršna datoteka koja pak 
automatizirano pokreće *.BAT datoteke za svaku pojedinu 
bušotinu čime se izbjegava njihovo manualno pokretanje. 
To znatno skraćuje vrijeme izrade litoloških stupova 
u slučaju većeg broja bušotina te omogućava potpunu 
automatizaciju. Kreiranje sumarne batch datoteke također 
se izvodi automatizirano koristeći VB makroe. Redoslijed 
pokretanja datoteka i njihovog izvršavanja prikazan je na 
slici 2.

Slika 2. Shema automatizirane izrade litoloških stupova s redoslijedom 
pokretanja datoteka i njihovog izvršavanja

Figure 2 Scheme for automated creation of lithological log plots with 
files running schedule and their execution.

KONCEPT VB MAKROA

Za automatizirani prijenos podataka iz Accessa u 
LogPlot korišten je program Excel i njegov programski 
jezik Visual Basic for Applications (VBA). Kreirana su 
četiri VB makroa uz pomoć kojih se vrši automatizirani 
prijenos podataka iz Access baze podataka u tekstualne 
datoteke *.DAT, *.TXT, *.BAT i sumarnu batch 
datoteku, a koje LogPlot koristi za automatiziranu izradu 
litoloških stupova. VB makroi su pohranjeni u Excel 
datoteku Access2LogPlot i prilagođeni su za jednostavnu 
upotrebu.

Postupak prijenosa podataka iz Accessa u LogPlot 
sastoji se u sljedećem: (1) u datoteci Access2LogPlot 
pomoću opcije File → Open otvara se Access baza 
podataka; (2) nakon otvaranja baze iz ponuđenog 
dijaloškog okvira odabire se upit koji se zatim unosi u 
Excel proračunsku tablicu; (3) nakon unosa upita u 
Excel proračunsku tablicu podaci se sortiraju prema šifri 
objekta i rednom broju intervala uz pomoć opcije Data 
→ Sort čime je Excel proračunska tablica pripremljena 
za prijenos podataka u LogPlot uz pomoć VB makroa; (4) 
u sljedećem koraku koristeći opciju Tools → Macro → 

Macros ostvaruje se prikaz dijaloškog okvira s popisom 
četiri VB makroa koji se pokreću sljedećim redoslijedom: 
(a) VB makro MakeDat kreira *.DAT datoteku za svaku 
bušotinu iz baze; (b) VB makro MakeTxt kreira *.TXT 
datoteku za svaku bušotinu iz baze; (c) VB makro 
MakeBat kreira *.BAT datoteku za svaku bušotinu iz 
baze; dok (d) VB makro MakeBatSum kreira sumarnu 
batch datoteku s popisom svih bušotina iz baze; (5) nakon 
kreiranja ulaznih datoteka vrši se provjera strukture 
*.DAT datoteka koristeći NoteTab Light tekst editor i Clip 
program (NoteTab Light, 2003) koji je posebno dizajniran 
za provjeru strukture LogPlot *.DAT datoteka; (6) u 
posljednjem koraku pokreće se sumarna batch datoteka 
koja inicijalizira kompletan proces automatizirane 
izrade litoloških stupova koji rezultira izlaznim *.HTM 
datotekama odnosno grafičkim prikazom litoloških 
stupova svih bušotina iz baze.

PRIMJERI PRIMJENE

Koncept i alati kreirani u ovom radu primijenjeni su 
na izradu litoloških stupova 2132 bušotine determinirane 
na području zagrebačkog i samoborskog vodonosnika te 
na izradu litoloških stupova 244 bušotine determinirane 
na području istočne Slavonije. Korištena je baza podataka 
(EGPV, 1988–danas) sadržavala 15853 determiniranih 
intervala. Automatizirana izrada litoloških stupova 
izvršena je koristeći računalo s procesorom Celeron 2.4 
GHz i 512 MB radne memorije, a trajala je 35 minuta. 
Primjer automatizirano izrađenog litološkog stupa 
prikazan je na slici 3.

Slika 3. Primjer automatizirano izrađenog litološkog stupa

Figure 3 Example of lithological log plot created automatically
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ZAKLJUČAK

Postupak izrade litoloških stupova predstavljen u 
ovom radu osigurava profesionalnu pohranu litoloških 
podataka u MS Access bazi podataka te osigurava alate za 
prijenos podataka u LogPlot. LogPlot alati pak omogućuju 
u potpunosti automatiziranu izradu litoloških stupova 
bušotina čime se u znatnoj mjeri skraćuje potrebno 
vrijeme obrade podataka.

Ovakvim konceptom koji je baziran na široko 
dostupnim i raširenim softverima kao što su MS Access 
i MS Excel te na VB makroima korištenim u ovom radu, 
ostvaruju se karakteristike skupih i često nedostupnih 
komercijalnih aplikacija koje osim alata za izradu 
litoloških stupova omogućuju i profesionalnu pohranu 
podataka ili pak komunikaciju s profesionalnim bazama 
podataka.
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DOSTUPNOST ALATA

Access baza za unos litoloških podataka (prazna), 
Excel datoteka Access2LogPlot s VB makroima za 
prijenos 

litoloških podataka iz Access baze u LogPlot, 
NoteTab Light tekst editor s Clip programom za provjeru 
struktura LogPlot tekstualnih datoteka (*.DAT) te 
predložak LogDesign datoteke (*.LDF) mogu se zatražiti 
bez naknade preko e-pošte od autora.
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AUTOMATED TECHNIQUE FOR CREATING LITHOLOGIC LOG PLOTS

Procedure for creation of lithologic log plots 
presented in this paper ensures professional storage of 
lithological data in MS Access data base and provides 
tools for transferring data to LogPlot. LogPlot tools 
enable automated creation of lithologic log plots which 
makes data processing less time consuming.

This concept based on widely accessible and used 
software like MS Access, MS Excel and VB macros 
used in this paper, provides characteristics of expensive 
commercial applications which, beside tools for creating 
lithologic log plots, have possibility for professional data 
storage or connection to data base software.

.


